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President’s Message

by Jacob Mosser, Ill, FPSA, HonNEC

ECCC had a unique opportunity to promote the

summer conference and its individual member
clubs at “Photoshop World” a conference and exposi-
tion that was held this past March in Boston. The three
day event at the Hynes Center had high end and fancy
displays by all the top names in photography and im-
aging software. Beyond the commercial booths there
were numerous hour long teaching presentations in ad-
jacent class rooms by all the top professionals in the
field.

We had a respectable booth amongst all the glitter of the commercial outfits
dispensing flyers for the NECCC conference and giving out the meeting times
and locations for all the New England clubs that belong to the Council. This was
particularly important as the majority of the individuals, if not all of those indi-
viduals who stopped by our booth, were interested in our activities but had no
idea camera clubs even existed. The booth would normally be well outside our
budget, but was provided to us at no cost thru the kindness of “Photoshop World”
and the efforts of Dave Singer, MNEC. The products and software on display
were most impressive. Like it or not, photography has become as much about
computers as cameras. Hopefully, this exposure will bring in more members to
the council clubs and increase our conference attendance.

Council officers and friends who gave of their time in making this happen were
organizer: Susan Mosser, FPSA HonNEC. Bill Barnett, MNEC who took care of
our email notifications, and;representatives at the booth: Chris Germain MNEC,
Linda & Rick Sereque APSA, MNEC,

Dave & Gail Godin MNEC and Barbara Rozavsky MNEC, with booth set-up
and tear down by Rick Cloran FPSA, MNEC and Jake Mosser FPSA, HonNEC.

Now that the warm weather is here, I hope you are getting out to make photo-
graphs and are formulating plans to attend the NECCC conference this July 10,
11 & 12 at UMass Ambherst. After the experience in Boston I must say NECCC
is a rare bargain cost wise, and I hope to see you there. Please visit the website
at www.neccc.org for continuing updates on the conference and new council in-
formation. Gail and David Godin our conference chairman have put together a
great weekend of programming and learning. Encourage your friends and fellow
camera club members to attend. They will thank you for it! If you have any ques-
tions or input on anything NECCC please contact me at jakemosser@comcast.net
or by phone at 978-664-2620

NECCC
NEW ENGLAND
CAMERA CLUB COUNCIL
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Yankee Photographic
Society Says Good Bye

he Yankee Photographic Society was formed 30 years ago

by Barbara Laatch-Hupp APSA MNEC as a chapter of
the Photographic Society of America (PSA). In the beginning
it met two or three times a year at various venues through
out New England offering day long seminars with notable
speakers such as Freeman Patterson and Galin Rowell. As
time went on Yankee found a home at the Lawrence Regional
Technical School and the format was expanded to include
multiple speakers, models and hi-jinks setups. After several
years of successful operation, the Technical School became
unavailable due to renovations. A search crew of about four
“Yankee” officers, took on the task of finding a new place to
meet. Over the course of three months we visited over 40 local
town high school and grammar schools. Finally with the help
of Jon Hanniford paving the way with the town officers, the
Danvers High School, became our long-standing final host.

At some time during the transition from Lawrence Re-
gional to Danvers High School, PSA felt it necessary to place
unacceptable conditions on it’s “Chapters”. The result was
“Yankee” surrendered its PSA charter and became a separate
organization, but retained its affiliation with PSA as a club.

“Yankee” has enjoyed a long and happy relationship with
Danvers High School but all good things must end.The Dan-
vers High School is also going to be renovated. Although the
auditorium would be useable for a while the Back IMC rooms
where we do the set-ups and model shoots would not. As
many of you now know our liaison Jon Hanniford is also re-
tiring. These two items together, among others, have brought
us where we are today conducting our last seminar this past
spring after 30 years of service to the Photographic commu-
nity. Yankee will continue in name only offering Gold Medal
Awards to major photographic events in New England, until
we run out of medals.

Many of you have taken advantage of Yankee’s excellent
studio style model shoots. The good news is much of the team
that made them possible will continue to make them avail-
able several times a year at the Greater Lynn Photographic
Association. GLPA holds four model shoots a year open to
the public, and for a small fee of $10 to $15 you will be able
to shoot the models with the same lights and back grounds
you had at Yankee. Beyond that GLPA is considering doing
Yankee style photo events in the future. This would be at our
Boston Street, Lynn location. These presentations would be
on a smaller scale, on a Saturday in our main hall. We are also
planning on some set-up days for next year. Those interested
can go to our website at www.greaterlynnphoto.org. for fu-
ture opportunities and a map to the club. From all the Yankee
officers and workers we bid you good night!

Susan Mosser FPSA HonNEC Program Chairman

New England Camera Club Council, Inc.
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NECCC Nominating
Committee Report

he NECCC Nominating Committee presents the fol-
lowing slate of Officers for the 2009-2010 season of the
New England Camera Club Council:

President: Raymond Guillette, MNEC

Treasurer: John Fuller FPSA, MNEC, AFIAP

Secretary: Mary Campagnolo, APSA, MNEC

Clerk: Abraham J. Reisman, APSA, HonNEC

Chairman of the Board: Jacob Mosser I1I, FPSA, HonNEC

Vice Presidents:
William B. Barnett, AFIAP, MNEC
Lois E. Clarke, FPSA, EPSA, HonNEC
Daniel Charbonnet, FPSA, MNEC
Kenneth Cook, Jr., MNEC
James L. Dionne, MNEC
Michael DiStefano, MNEC
James Gallagher, MNEC
Karen Geaghan
Chris Germain, MNEC
David Godin
Gail Hansche-Godin, MNEC
Antoinette Gombeda, HonNEC
Robert B.Gorrill, APSA, MNEC
Cynthia Gosselin, MNEC
Bruce A. Grant, HonNEC
Jane W. Guaraldi, MNEC
Mary K. Hall, APSA, MNEC
Roy L. Marshall, MNEC
Susan Mosser, FPSA, HonNEC
Richard A. Novak, MNEC
Barbara E. Rozovsky, MNEC
Richard Sereque, APSA, MNEC
Harold Sisken, MNEC
Pamela S. Stanley, MNEC
Steve Tierney, MNEC
Arthur Vaughan, MNEC
Shiv Verma, MNEC
Audrey A. Weigold, APSA, HonNEC
Olive M. Weingart, APSA, HonNEC
David Yankee, MNEC

Respectfully Submitted,
The Nominating Committee

Antoinette Gombeda, HonNEC (Chairman)
Shiv Verma, MNEC
Audrey A. Weigold, FPSA, HonNEC
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NECCC 64th Annual

Conference
To be held at the University

of Massachusetts, Amherst, MA

July 10, 11, 12, 2009

Come join us for wonderful weekend of learning, shar-
ing and camaraderie. There will be programs of inter-
est for all levels of photographers. Lewis Kemper and Tyler
Stableford, two of Canon’s ‘Explorers of Light’, will share
their exciting experiences in adventure photography with us.
Tyler will be teaching the ins and outs of selling World Class
Stock images.

Our feature presentation will be Rosanne Pennella, of
Arlington, VA, an internationally renowned travel photog-
rapher, instructor, writer and speaker on the topics of travel
photography and digital imaging. Rosanne will take confer-
ence attendees on a round-the-world tour with her graphic,
intimate and color-saturated images taken on all seven conti-
nents. Rosanne is one of Nikon’s ‘Legends Behind the Lens’.

We will be running two pre-conference workshops con-
currently Friday morning. Workshop 1 is ‘Photoshop Ele-
ments for Intermediate Users’ and Workshop 2 is ‘ProShow
Gold Slideshow’. A personal laptop will be required to at-
tend the pre-conference workshops. Sign up early as space
is limited. We will also have pre-conference individual port-
folio reviews. Have an expert photographer kindly critique
your images on a one-on-one basis.

Looking to buy new equipment? Nikon and Canon will be
lending their top-of-the-line equipment so you can try before
you buy. If you decide to buy, vendors will be present with
special conference deals.

We are offering ‘Back to Basics’ programs for new pho-
tographers and those who need to brush up on techniques.
There will be a program by Joe McDonald on high-speed
flash photography, Andre Gallant on creative photography
and Lou Jones will teach creative techniques with flash. El-
len Anon and Josh Anon will show you how to make your
image the best that it can be in their program on digital im-
agery.

Bring your cameras as there will be many opportunities to
photograph models, flowers and creatures great and small.
The beautiful Amherst Campus has wonderful architectural
photo ops. Dual projection and Print competitions will be
available for attendees. Air Conditioned dorms available.
Register online at our website. It has all the latest conference
information. Website: www.neccc.org
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The Freeman Patterson
Effect

By Rick Cloran

We have all admired those soft dreamy images that mas-
ters like Ray Guillette, Andre Gallant, Jake and others
have shown from time to time. These images were generally
based on taking one slide in sharp focus at a small aperture
like F 22 and a second slide with the same scene shifted
out of focus using an aperture of F 4 or F 5.6. The slides
were then montaged. Because they were putting two slides
together, the makers would often adjust the exposure on one
or both images to the over side to avoid having too much
density. They might even zoom the lens prior to the second
exposure to keep the out of focus image slightly larger, but
in about the same proportion as the sharp initial exposure.

While their techniques may have varied, they all followed
the general lead of a well known photographer named Free-
man Patterson who, to the best of my knowledge, pioneered
the dreamy style that results. The good news is that a few
of the Photoshop gurus have been able to simulate this effect
using a single digital image. The following steps closely fol-
low those recommended by Mark Johnson.

Open a suitable image. Try using a bed of flowers or a
tree with autumn foliage if you never tried the slide version
before, since not every subject looks good with this tech-
nique. Duplicate the background layer and change the blend
mode to Multiply. Those of you with CS3 or CS4, convert
the layer for Smart Filters before going further. (Sorry Ele-
ments workers, this option isn’t available for you.) Apply a
Gaussian Blur so that the effect looks dreamy. Settings be-
tween 5 — 15 pixels generally work well, but feel free to
experiment.

While still on the Background Copy go to Edit > Trans-
form > Scale (In Elements Transform is found under the Im-
age menu.) Make sure the link between the height and width
boxes is checked and apply a setting of between 101 and 103
in either the width or height box (the other box will adjust
automatically) and select OK until the dialog closes. This
is an optional step, but it provides the size adjustment effect
that we used to get by zooming on the second out of focus
image.

The result is effectively complete, but it often lacks a nice
sense of highlight and shadow. To add these, with the Back-
ground copy active create a new Levels Adjustment Layer.
Drag the White input marker (the top scale of the two is the
input values) to the left until you see the brightest pixels
turning white then back off a bit. Next drag the Midtone
marker to the left until the middle tones open up. There are

Continued on next page
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New England Camera Club Council
Color Slide of the Year Competition

For the 2008-2009 Season

he slides listed below placed first, second or third in the three inter-club competitions and are eligible for the Color
Slide Of The Year Competition. These slides must be mailed to Lois Clarke, FPSA, EPSA, HonNEC, 130 Mill Street,
Wethersfield, CT 06109 to arrive by June 20, 2009. Any slides received after that date will not be included in this year’s

contest.

Class AA Title

Eastern Maine CC Wave Curve

Greater Lynn PA Mill on Glade Creek
Greater Lynn PA It Feels So Good
Manchester CC Cinderella’s Castle
Manchester CC Seeds-36
Manchester Camera Club Limped Hose
Photographic Society of RI Fisherman

Photographic Society of RI
Seacoast CC

Fall in the Tetons
Jack Frost Window Painting #35

Springfield PS North Stonehurst
Springfield PS Cloudless Sulpher
Class B Title

Boston CC Bahai Shrine
Candlewood CC Silky Stream
Candlewood CC Lone Windmill
Candlewood CaC Yellowstone Light
Northern Rhode Island CC Woman & Baby
Northern Rhode Island CC Two by Two
Northern Rhode Island CC Fly Me To The Moon
Quinebaug Valley PC Quiet

Seven Hills CC Preening
Windham PC Pine St.

Maker

Sally Arata
June Visser
Marilyn Cloran
Tom Murray
Dick Hudnall
Bob Legg
Mary Doo
Dennis Goulet
Paul D. Hopkins
Steve Goldstein
Judio Bolio

Maker

Henry Winkleman
Don Brooks
Frank Gardner
Frank Gardner
Deb Bettencourt
Tom Collins
Jeannine Brien
Ed Savoie
JoAnn Audette
Mike Wengloski

Continued from previous page

no hard and fast values here so make the adjustment to get
the look that you like. Fill the layer’s mask with black to
hide the lightening effect entirely. Now using a medium size,
soft edged brush set for 50% opacity or less and with white
selected as the foreground color, paint on the layer mask in
white to “reveal” the highlights where you want them. Don’t
be afraid to vary the opacity of the brush or to make multiple
passes to adjust the extent to which the lightening is seen.

Select the Background layer to make it active. Add an-
other Levels adjustment layer. This time drag the black out-
put marker (the bottom of the two scales is the output scale)
to the right until you see the shadows open up. Again, there
is no hard and fast value for this, just what you like. Fill

New England Camera Club Council, Inc.

the layer’s mask with black to hide the effect. Now using
a medium to small, soft edged brush at 50% or lower opac-
ity, paint with white over the shadow areas that you want
to bring out to let the adjustment show through. This too is
something you need to do to taste.

You’ll want to save the finished working file as a PSD or
TIFF file with all of the layers present. You can then flatten
it and size it for projection or printing. It should go without
saying but, since our intent was to get a soft dreamy look you
won’t bother sharpening the final output.

NECCC Bulletin - Spring 2009 Page 5



2009 Glennie Nature
Interclub Exhibition
Results Announced

Submitted by Charlie Burke, Chair

he George W. Glennie Memorial Nature Interclub Exhi-

bition was held on March 28, 2009 before an audience
of about 50 members and guests. Many of the attendees ex-
pressed their appreciation for having the opportunity to view
so many strong and varied images. They also said that they
were already looking forward to next year’s event.

The all digital format continued to show merit as 95 clubs
(versus 52 in 2008) participated in the event. There were en-
tries from 20 states (CT, DE, FL, GA, IL, KY, MA, MD,
ME, NC, NH, NJ, NY, OH, PA, RI, SC, TN, TX and VA)
as well as Australia, Canada, New Zealand and the United
Kingdom. Continued growth is expected in the coming years
as a number of the invited, but non-participating, clubs in-
dicated that they would be better prepared to submit entries
next year. Invitations will also be extended to all clubs
world-wide, as well.

The Exhibition is open to all photographic clubs and all
are welcome to participate. Any club that did not receive an
invitation for this year’s event should contact Chair Charlie
Burke (nichburke@yahoo.com) to insure inclusion in the
2010 invitation list. It is an expressed goal of the Exhibition
to have as many clubs as possible join in this unique event.

The Judges Panel consisted of Marilyn Cloran, FPSA,
MNEC Greater Lynn Photographic Association; Paul Smith,
MNEC, Gateway Camera Club and Shiv Verma, Stony
Brook Camera Club. After scoring the 945 images, they also
assisted in making “Best Of” and Merit Award selections in
the various individual categories. In addition, they choose a
personal favorite among the high scoring images. The Chair
made a selection, as well. In a closing remark, the Judges
indicated that some images would have scored higher if they
had not appeared to have been overworked (generally, too
much color saturation and sharpening).

Top 10 Highest Scoring Clubs
(Including Ties) for 2009

1. Cape Cod Viewfinders Camera Club (MA) 231 points*
2T Boston West Photographic Society (MA) 223 points*
2T Fort Myers Camera Club (FL) 223 points*
3T Gateway Camera Club (MA) 220 points*
3T Massachusetts Camera Naturalists (MA) 220 points*
3T Stony Brook Camera Club (MA) 220 points*
3T Welland Camera Club (CAN) 220 points*
4T Charter Oak Photographic Society (CT) 219 points*
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4T Merrimack Valley Camera Club (MA) 219 points*
5 Houston Underwater Photographic Society (TX) 218 points
6 Amersham Photographic Society (UK) 217 points
7 New Haven Camera Club (CT) 216 points
8 Camera Naturalists Photo Club (NJ) 215 points
9T Greater Lynn Photographic Association (MA) 214 points
9T Photographic Society of Rhode Island (RI) 214 points
9T Tandridge Photographic Society (UK) 214 points
10T Manly Warringah Rugby Leagues Club Camera Club
(AUS) 213 points
10T Sarasota Camera Club (FL) 213 points
* Will be presented an award.

The general categories for the Exhibition were Amphibi-
ans, Birds, Botany, Insects, Mammals, Marine Life, Reptiles
and Scapes. A number of categories were further divided,
based upon the variety and number of specimen images re-
ceived. Altogether, 23 categories were established, as shown
below. A “Best Of” and a select number of Merit Awards
were chosen for each category. The Merit Award winners
may viewed by visiting the Exhibition web site (www.glen-
nie-exhibition.com).

In addition to the Judges’ Choices and the Chair’s Medal
(presented by the Yankee Photographic Society), awards
were also given for the Best of Show and Best Wildlife (for
the first time).

Individual Awards:

Best of Show: Osprey With Flounder For Dinner, Lisa Cuchara,
New Haven Camera Club (CT).

Best Wildlife: Loon Feeding Chicks, Ed McGuirk, Boston West
Photographic Society (MA).

Judge’s Choice (Marilyn Cloran): Grizzly Family, Scott Bennett,
Toronto Camera Club (CAN).

Judge’s Choice (Paul Smith): Tawny In Flight, Tony Bamford,
Amersham Photographic Society (UK).

Judge’s Choice (Shiv Verma): Good Catch, Dennis Goulet,
Photographic Society of Rhode Island (RI).

Chair’s Choice (Yankee Photographic Society Medal): Trout
For Lunch, Bob Labuski, Sweetbriar Nature Photography Club

(NY).

Best Amphibian: Waiting For A Kiss, Peter Ferguson, Welland
Camera Club (CAN).

Best Predator Bird: Dinner Delivery, Monica Baer, Milford
Camera Club (CT).

Best Shore Bird: Its Mine, Joe Moran, Fort Myers Camera Club
(FL).

Continued on next page
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Continued on next page

Best Swimming Bird: Loon Hug, Henny Smith, Stony Brook
Camera Club (MA).

Best Wading Bird: Lunch, Rosalie Kreulen, Fort Myers Camera
Club (FL).

Best Water Bird: Mom Taxi, Peter Ferguson, Welland Camera
Club (CAN).

Best Large Bird: Head To Head, James Stevens, Cranbury
Digital Camera Club (NJ).

Best Medium Bird: Bohemian Waxwing, Wendy Mclntosh,
Greater Lynn Photographic Association (MA).

Best Small Bird: White Browed Wood Swallow Feeding Young,
Scott Salter, Ryde Eastwood Leagues Camera Club (AUS).

Best General Botany: Yellow Pholiota, Tom Linton, Welland
Camera Club (CAN).

Best Flower: Showy Lady Slipper, Bill Blanton, Toledo Camera
Club (OH).

Best Butterfly: Butterfly, Barbara Statas, Gaithersburg Camera
Club (MD)

Best Dragonfly (Tie): Brown Spotted Yellow Wing, Scott
Foster, Gateway Camera Club (MA); Dragonflies Mating, Gail
Hansche Godin, Massachusetts Camera Naturalists (MA).

Best Predator Insect: Green Lynx With Bee, Art Vaughan,
Merrimack Valley Camera Club (MA).

Best General Insect:
Photographers (CT).

Paper Wasp, Jim Talarino, Flagpole
Best Predator Mammal: Grizzly Dental Exam, Ed McGuirk,
Boston West Photographic Society (MA).

Best Large Mammal: Mother’s Love, Margaret Hooper,
Whangarei Camera Club (NZ).

Best Medium Mammal: Zebra Challenge, Eleanore Avery,

Dallas Camera Club (TX).

Best Small Mammal: Monkey See Hand, Suzanne Dater,
National Institutes of Health Camera Club (MD).

Best Marine Life: Hammertime, Tom Collier, Houston
Underwater Photographic Society (TX).

Best Reptile: Blue Tongue Lizard, Joyce Metassa, Wynnum
Bayside Camera Club (AUS).

Best Scape With Water: Dusk At Mammoth, Jacki Dikert,
Camera Naturalist Photo Club (NJ).

Best Scape Without Water: Aurora Borealis, John Fuller, Stony
Brook Camera Club (MA).

New England Camera Club Council, Inc.
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Cape Cod F.O.G.

W.Ernest Holmes ( Ernie )
Club Rep & Organizer

small group of photographers with an interest in Film
nd photography meets once a month at the Cape Cod
Museum of Art,RT. 6A, Dennis, MA. The meeting starts at
6:30 PM with a greeting and friendship period. Then at 7
PM a Video or a live program. The group takes a active part
in the programs by bringing in items to talk about or sharing
information with each other. There is a lot of learning and
fellowship shared by the members about photography.

Early in the spring the group decided to accept an invita-
tion to do an exhibit called a One Night Stand at the Mu-
seum. So the planning and work started. We designed and
built display stands for the prints. One of our members spent
many hours building the stands, many Thanks Bill. All of the
members worked very hard to put the show together.

The night came November 6th. The 14 members moved
the display stands, prints, refreshments and setups in and
were done in a little over 2% hours with a brief rest. We
greeted over 150 people that came to the 2 hour show. Then
we took it all down and took it home with us. It was a lot of
work but well worth the effort. Also, this year we are do-
ing another show at the Cultural Center of Cape Cod, in
S.Yarmouth, MA. This will be a invitational exhibit. Open to
the public June 24th to July 5th with an opening June 26th.

Many of the membe s went on a photo shoot March 21 to
Provincetown. Several of the members used film, 35mm and
120 roll film. It was a clear day and a great time was had by
all. We look forward to 2009 and a lot of photography.

What is A-DEP?

by Robert B. Gorrill, APSA, MNEC

Many owners of Canon digital SLR’s have no doubt
noticed the A-DEP setting on their cameras' control
dial but have never used the setting. It is a very useful feature
on those cameras and one that you will come to use once you
understand what it can do for your photography.

If you have been around photography for a while you no
doubt used the depth of field settings on your manual focus
lenses or consulted a chart. That is old hat with the newest
incarnation narjed as A-DEP as it works with the multiple
focus points where you make sure that what you want to
be in sharp focus is locked into the nearest and the farthest
LED points in your viewfinder. You do this by depressing
the shutter release half-way to get the points locked and
then, recompose and take the picture by depressing the shut-
ter release all the way down. Try it, you’ll like it.
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NECCC 2008-2009 Interclub Color Slide Competition

he spring competition of the New England Camera Club Council Interclub Color Slides was held on Monday

March 9, 2009 and hosted by the Manchester Camera Club. The following members of the club assisted with the
competition: Joe Drapeau, Bob Falco, Dick Hudnall, Karen Hudnall, Bob Legg, Sally Turner, and Walter Friesendorf. The
judges for the competition were: Roger Treadwell, Eric Arnold, and Crystal Nadeau. Only one club in Class A registered
for this year’s Interclub Color Slide Competition. As a result Class A has been eliminated.

CLASS AA

Clubs Nov 2008 Jan2009 Mar 2009 Total Score  Final Club
Score Score Scoe Score Standing

Photographic Society of Rhode Island 91 * 100 84 First 275 First

Greater Lynn Photographic Assn 99 90 83 Third 272 Second

Manchester Camera Club 73 +23* 100 76 272 Second

New Haven Camera Club 92 88 77 257 Third

Springfield Photographic Society 95 76** 84 First 255

Westfield Camera Club 89 90 72 251

Simsbury Camera Club 86 * 89 74 249

Seacoast Camera Club 86 T1H* 76 233

Eastern Maine Camera Club 100 88 - 188

* Make up for November competition.

** Make up for January competition.

Class AA, Ribbon Winners:

Place Title of Slide Maker Camera Club Score

First It Feels So Good Marilyn Cloran Greater Lynn Photographic Assoc. 26

Second North Stonehurst Steve Goldstein Springfield Photographic Society 24

Third Cloudless Sulpher Judio Bolio Springfield Photographic Society 23

Third Jack Frost Window Painting #35 Paul D. Hopkins Seacoast Camera Club 23

HM  Fawn and Reflection Michael Di Stefano Photographic Society of RI 22

HM  Bow Roof Barn Dennis Goulet Photographic Society of RI 22

CLASS B — Clubs Nov 08 score  Jan 09 score  Mar 09 score Total Score Fina Standing

Candlewood Camera Club 86* 87 First 73 Third 246 First

Northern Rhode Island Camera Club &9 79 Third 78 First 246 First

Quinebaug Valley Photography Club 83 84 Second 68 235 Third

Traveling Camera Club 78 77 70 225

Seven Hills Camera Club 411 66 *** 74 Second 181

Windham Photography Club 86 - 66 152

Pine Meadow Photographers 81 61 *** - 142

Boston Camera Club 40%* 47 ** 35%* 122

Heritage Village Camera Club 38%* - -

* Make up for the November competition.

** Two entries.

*#* Three entries

1 Two entries both were make ups for the November competition

Continued on next page
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Continued from previous page

Class B, Ribbon Winners:

Place Title of slide Maker

First Yellowstone Light Frank Gardner
First Fly Me to The Moon Jeannine Brien
First Preening JoAnn Audette
HM  The Memory John McAleer

Camera Club Score
Candlewood Camera Club 22
Northern Rhode Island Camera Club 22
Seven Hills Camera Club 22
Seven Hills Camera Club 20

Congratulations to all the winners. In Class B, congratulations to the Northern Rhode Island Camera Club and the
Candlewood Camera Club who tied for first place for the year. In Class AA congratulations to the Photographic Society of
Rhode Island who finished in first place for the year. Thank you to the Manchester Camera Club for hosting the spring com-
petition. Slides that are eligible for slide of the year in Class B and Class AA. Should be sent to Lois Clarke FPSA, EPSA,

HonNEC to arrive no later than June 20, 2009.

Harold Sisken, MNEC
Color Slide Competition Chairman

Camera Care
by Gerald L. Sanford, MNEC

Sanford Camera Repair, Arlington, MA

egretfully, this will be my last “Camera Care” column

for the NECCC Bulletin as [ have decided it’s time to
retire now that [ have reached 90 years young! For many
years I have tried to present both the serious and humor-
ous side of life with your photo equipment, with things you
could do to avoid equipment failure. I hope to have been
successful with my stories and information. Our family run
camera repair business will continue to operate as usual.

I have two DISASTER OF THE MONTH stories to re-
port to you. One of our customers put his Canon Power Shot
A610 in his back pants pocket while ice skating. Unfortu-
nately he took a fall backwards and went down on the cam-
era. The other unfortunate mishap involved a Nikon Cool
Pix that fell off a boat in Moose Head Lake Maine and got
caught between some rocks. Both cameras were able to be
brought back to life by our technicians.

The lens test for this issue was an aftermarket Quantaray
lens with good results. Happy Spring and enjoy your pho-
tography!

PROJECTION RESOLUTION
SCORING
Excellent.......... 181-228 lines/mm
Very Good.. ........ 128-161 lines/mm
Good.............. 80-114 lines/mm
Average............ 50-72 lines/mm

28-45 lines/mm
16-25 lines/mm

Below Average. . . ..
Rejection Average . . .

Central area equals a 25 cent coin
placed over the slide. The rest are
edges.

New England Camera Club Council, Inc.

NECCC Bulletin - Spring 2009

The Digital Corner
by Elena Mc Tighe

What is Digital Raw?

We hear a lot now about shooting in the camera raw for-
mat. A digital raw file is composed of
1. The raw sensor data from the camera.
2. The metadata (which records exactly how the
picture was shot — iso setting, shutter speed, etc.
The raw file simply records the luminance value of every
pixel, so that the raw file is actually a grayscale image. It
contains color information.

The raw converter interprets the sensor data and controls
white balance, color interpretation, tone mapping, noise re-
duction, antialiasing and sharpening. All of which, are in
your control when you convert the raw data.

Simply put, shooting in digital camera raw is the digital
equivalent of a film negative.

If your camera offers camera raw, you should be using it
because in the conversion process, you can control the scene
interpretation. You can even reinterpret the basic exposure
by resetting the white and black points.
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33rd Greater Lynn

International Salon

fter a very long 2 days of judging, the 2009 interna-

tional is over. Our 2009 exhibition was again a duel
projection judging, however we did things a bit differently
this year. In order to give the slides the best viewing pos-
sible, we judged all the slides first on Friday night than went
into the digital judging. Our total entrant count this year was
an amazing 1088 entrants, with 150 of those being slide en-
trants. This is the largest number of entrants we have ever
had, and while it’s great to be the biggest one section ex-
hibition in the world it’s also a huge amount of work. This
year saw major changes in our exhibition. We made online
registration and PayPal available to our entrants on an indi-
vidual basis. If you entered through a club you still had to go
through the old route of mailing it but that may also change
next year. With all this digital work came new helpers to
the exhibition.

Andrew Katsampes set the online process up and con-
tinued to make changes as necessary during the submission
time to make it easier to use. Pam Stanley MNEC took on the
task of receiving the digital submissions and preparing ev-
erything for the judging day, as well as designing and setting
up the program used for the judging. My deepest gratitude
goes out to both of them as this could not have been done
by me alone. Although I am learning the lingo, my digital
and computer knowledge is very limited. As a matter of fact
I am still in the stupid mode!! On the day of the judging we
had 5 laptops linked together and all went as smooth as silk.
My thanks to the operators of the laptops, Dan Charbonnet,
Rick Cloran, Amy Musinsky, Pam Stanley and Lori Trem-
baly. My thanks also to Shiv Verma (Stony Brook CC) for
his donation of the magic boxes that link them all together
on one network.

Last year’s show was great in its new dual format, but this
year’s show was all digital, and seen by over 500 people.
Our showcase presenters Barbara Rozavsky MNEC and Dan
Charbonnet FPSA, MNEC did an outstanding job of put-
ting the images to music into a spectacular showcase that
was a great end to over eight months of hard work. All of
the accepted slides (about 170) were scanned for the show.
Although their acceptance rate was the same as the digital
images, there just weren’t enough of them to make up their
own portion of the presentation. Our percentages for slides
and digital were excellent with slides winning 5 of the 30
medals given out this year.

This year’s judges were Ed McGuirk from the Boston
West Camera Club; Shiv Verma MNEC from the Stony
Brook Camera Club; and Barbara Rozavsky MNEC from
the Greater Lynn Photographic Association. My thanks to
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the judges who were great and very patient during this long
one and half days. At least this year we didn’t have a major
snow storm to deal with.

As I stated, this year’s exhibition had 1088 entrants, an
increase of 158 over last year’s. There were 938 digital en-
trants and 150 slide entrants. About 360 of the total num-
ber of entrants were from the six New England states, an
increase of 20 compared to last year’s numbers.

This is not an easy exhibition to get an image accepted
into as the number of entrants is so large and the work is the
best from all over the world. Only about 32% of the 4,332
images submitted were accepted for the show. Images are
judged on a scale of 3—15 points, which each judge scoring
1-5. The accepted score (an image scoring high enough to
be in the show) this year was 12 points or higher.

Of the 37 medals given this year, 14 were awarded to
New England entrants. This is down by 5 from last year’s
stats. Three PSA and six FIAP Honor Awards are given to
higher placed images not winning a medal. Two of the FIAP
Honor Awards and all three of the PSA Honor Awards went
to New England entrants. In addition, 50 New England en-
trants received GLPA Honor Awards. This is a very high
increase of 20 HA from last year. Another great showing for
New England entrants.

Congratulations to all who have an image accepted into
the show. If you continue to enter these types of exhibi-
tions, these acceptances will count toward your star rating.
Star ratings are fun to try for and an honor to achieve. Your
name gets known as a top photographer when you list a star
rating after it. Further information on star ratings can be
found at www.psa-photo.org

Congratulations also to the Merrimack Valley Camera
Club of Andover, MA for winning the largest club partici-
pation medal for the 4th year in a row. This year with 49
entrants, again an unheard of feat!

The Best Club award went to Stony Brook Camera Club
of Wretham, MA, who took first place by 5 points. In 2nd
was Boston West Photographic Society of Framingham,
MA and 3rd went to The Photographic Society of Rhode
Island.

New England members receiving gold medals were:

The New England Camera Club Council Medal for Best
New England Entrant went to Gordon Yu, of Quincy, MA,
a member of the Boston Camera Club, with his image
“Rebecca 1.

The FIAP Bronze Medal went to Joan Shirley of Wrentham,
MA of the Stony Brook Camera Club with her image
“Osprey Lunch”

Continued on next page
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Continued from previous page

The Charles Woolnough Award for Best Seascape went to
Ian Dicker, of Sudbury, MA a member of the Boston West
Photographic Society with his image “Portland Sunrise”

Eva Gryk of New Britain, CT won the David Hughes Medal
for Best Abstract with her image “St. Pio’s Stairway San
Giovanni, Rotondo, Italy”

Natalya Pluzhnikov of Providence, RI, a member of
Photographic Society of Rhode Island won the Michael
Videtta Award for the “Highest Aggregate Score” by a New
England Entrant.

Marilyn Cloran, FPSA, MNEC of Swampscott, MA, a
member of the Greater Lynn Photographic Association won
a special medal in the Landscape category with her image
“Shadow at Sunset”.

Michael Goodman MNEC of Newfields, NH a member of
Boston West Photographic Society won the Best Landscape
Medal with “Before Sunrise Dallas Divide”

Ted Haley of Hope, RI, a member of the Photographic
Society of Rhode Island, won Best Photojournalism with
“Rescue 1.

Dennis Gignac of Cranston, RI, also from the Photographic
Society of RI won Best Candid Person with his image
“Mother and Child”.

Lisa Smith of Windham, NH a member of the Merrimack
Valley Camera Club won the German IIWF award for
highest scoring image with “Ice Princess”.

Sandy McMillan of Farmington, NH a member of the
Seacoast Camera Club won a Chairman’s Choice Award
with “Smokey”

John Fuller FPSA, MNEC of Norfolk, MA a member of the
Greater Lynn Photographic Association won the Charles
Miller Award for best image by a member of the organizing
committee with his slide “Emperor Penguin Family 1”.
John also won the “German Mega Circuit” Award for Best
wildlife with his slide “Bald Eagle Perch”.

Susan Mosser, FPSA, HonNEC, Chairman
Greater Lynn International

GLPA International
NECCC Gold Medal
for Best New England
Entrant - Gordon Yu,
Quincy, MA of Boston
Camera Club with
:Rebecca 1”

New England Camera Club Council, Inc.
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Photographic Society of
America Council Challenge

ECCC will again be entering this challenge in conjunc-

tion with the PSA conference in Yellowstone in Sep-
tember. We entered last year and did very well overall. We
will be entering in slides, digital and prints. We never have
a difficult time getting the digital images but are always
scrambling for the slides and particularly the prints. We need
10 slides and 10 prints by 10 different makers. You can enter
both slides and prints, but images have to be different and
can only enter one image in each.

If you belong to a New England club that belongs to the
New England Camera Club Council and would like to par-
ticipate in this, we would love to have your work. We re-
ally need your help as we placed last in prints last year and
would really like to do better. Unfortunately prints can not
be mounted. Please see full instructions for the prints below.
Slides may be cardboard or glass mounted. Prints will be
handled by Mary Hall and slides by Susan Mosser. If you are
interested in submitting a digital image you should contact
Bill Barnett at barnettw@optonline.net. Deadlines for sub-
missions is June 10, 2009.

Prints

Photographic prints may be color or monochrome, com-
mercial or inkjet (all prints will be judged in one division).
Prints must not be mounted or matted. Minimum print size
is 8” x 107, and the maximum print size is 8 2" x 12”. The
photographer’s name, title of print, council affiliation, and
print orientation arrow should be labeled on the back of each
print, but the maker’s name should not be attached to the
front of the print in any fashion.

Please give or sendslides to Susan Mosser, 173 Central
St., No. Reading, Ma 01864. s.jmosser@comcast.net

Send or give prints to Mary Hall, 200 Burkhall St. #205,
Weymouth, Ma 02190 hallmaryk@verizon.net Your work
will be returned to you after the PSA conference about the
end of Sept. 2009 .Thanks for all your help with this.
Susan Mosser FPSA, HonNEC
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Photographic Society of

America International
Exhibition
his year, the PSA Nature section will again be judged
here in Massachusetts with Dan Charbonnet, FPSA,
MNEC as chairman. The judging will take place at the

Greater Lynn headquarters on August 15, 2009 with a clos-
ing date for entries to be received by August 10, 2009.

Entry forms have not been finalized yet but will be avail-
able by the end of April. You can go to the PSA website
(www.psa-photo.org) for more information. Along with Na-
ture PSA also offers about 20 other sections such as prints,
phototravel, open, photo journalism stereo and electronic
imaging. These will be judged elsewhere through the USA,
but you can certainly enter them also if you wish.

The nature section will accept slides and digital. Slides to
mailed to Susan Mosser and digital to come online to Shiv
Verma. The judging will be open to the public and the Great-
er Lynn hall is air conditioned. Also, at the same time, the
PSA Nature Image of the Year will be judged. The competi-
tion is open to all images that have won a Nature medal in
approved PSA exhibitions in the year 2008. This is the best
of the best being judged and seen.

We have some fantastic nature photographers here in New
England. Lets see a big turnout for this exhibition. The show
will be part of the PSA Conference this September in Yel-
lowstone.

The PSA Website

Have you visited the Photographic Society of America’s
website lately? If you haven’t been there for a while it
might prove to be an interesting visit and one that you will
continue to visit on a regular basis.You can find the website
at http://www.psa-photo.org. The first thing that you will
notice is the slide show of accepted entries in various PSA
exhibitions and competitions.

Some of the areas are reserved for members only but
much of the website is open to anyone who has an interest in
photography. Here you can check out the various divisions
of PSA and see what is being offered to members. For new
members there is a special website just for them with access
to mentors in various fields of photography and where, as
a new member, you are invited to submit a favorite image
to be displayed on the website. There is much to be gained
from a membership in PSA and you are invited to take a look
and see if it is right for you. Have a look at the Study Groups
of the Electronic Imaging Division at http://www.psaphoto.
org where you can see what others are doing.
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Turning Slides to Digital
Without a Slide Scanner

By Jake Mosser FPSA, HonNEC

Thru the kindness of a good friend I came into the pos-
session of a Nikon Coolscan. But it proved to be slow
and problematic. So how to copy slides to digital cheap and
clean?

First you need a camera and lens combination that will
close focus to fill the frame with the slide film chip or rea-
sonably close to it. [ use an old 100mm macro lens adapted
to fit a Canon 40D. Next you need to hold the slide in place
for re-photographing, this is where your ingenuity comes
in.

1) Take a medium sized corrugated cardboard box and
cut off the top flaps.

2) Then cut a 1 3/4 X 1 3/4 square hole in the center of
one end of the box.

3) Inside the box at the opposite end from the square hole
tape a sheet of very white paper.

4) Position a lamp to illuminate the white paper with-
out it shining on the outside of the box at the end with the
square hole. A simple goose neck desk lamp works well.

Use a common (tungsten) light bulb and set your camer-
as white balance to “tungsten” and shoot in both high qual-
ity JPEG and RAW, you can work with which ever format
you like for adjusting color cast, shadows and highlights
as needed. The slide itself is centered over the 1 3/4 X 1
3/4 square hole outside the box and held in place with the
blue painters tape available at any hardware store. Set your
camera on a tripod and the box on a table, fine focus is done
simply by nudging the box back and forth (auto-focus off).
Make three exposures, one as metered, one plus a stop or so
and a third minus a stop or so.

To me, photography is the simultaneous recognition,
in a fraction of a second, of the significance of an
event.

To photograph is to hold one’s breath, when all facul-
ties converge to capture fleeting reality. It’s at that
precise moment that mastering an image becomes a
great physical and intellectual joy.

To take photographs means to recognize - simultane-
ously and within a fraction of a second - both the fact
itself and the rigorous organization of visually per-
ceived forms that give it meaning. It is putting one’s
head, one’s eye and one’s heart on the same axis.

Henri Cartier-Bresson
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2009 PSA International
Newsletter Contest

Conditions of Entry: Each PSA chapter, council, or cam-
era club with a printed or electronic newsletter of one
or more pages, published two or more times a year is invited
to participate in the 2009 PSA International Newsletter Con-
test. Your organization must be a current member of PSA in
order to enter the contest.

Entry: Requires an electronic submission or four (4) iden-
tical printed copies of one regular issue published after June
1, 2008. A new PSA club or council in 2008-2009 may enter
an issue published after the date of PSA membership. An-
nual or special issues, yearly program schedules, rosters, di-
rectories, salon catalogs, or newsletters published only once
a year do not qualify. To aid in judging entries, overseas
entries not in English must include four (4) copies of sum-
mary or translation, not including advertisements. All four
printed copies of one regular issue newsletter must be fully
assembled. Have your entry weighed correctly for FIRST
CLASS MAIL. Entries received with postage due will not
be accepted. Mail entries flat, with cardboard, in a sealed
envelope. Do not use staples or paper clips to attach the entry
form to the newsletter as it can be damaged in transit. Elec-
tronic entries must be submitted as pdf files.

Entry Divisions: Chapter/Council; Small Club (4-75 members);
Large Club (76+ members)

Closing Date: June 1, 2009

Judging and Rating Information: Qualified judges, each
judging independently, will review your entry. Following re-
view, each judge will rate your entry in its total presentation
compared to entries in your division only. Points and awards
are determined from these ratings. The size of the newsletter,
quality of paper, printing process, or whether or not adver-
tisements are used have no bearing on points and awards.
Content, layout, good use of space, neatness, clean print,
ease of reading, simplicity, and style are of basic importance.
Before you enter please obtain a copy of the Judging Work-
sheet from the PSA website or Margaret Sprott, Director of
the contest-

http://www.psa-photo.org - dick_margaret@verizon.net

Fee: There is no fee, but all entries must be from PSA
member groups whose dues are currently paid.

Awards: 1st, 2nd, 3rd Place Awards, Runner-up ribbons,
Outstanding feature awards, the Arthur P. Henricks, Jr. Me-
morial Award (selected from the top rated newsletters in
each of the three divisions). Announcement of these awards
will be made at the General Membership meeting at the 2009
PSA International Conference

2009 PSA International Newsletter Contest Entry Form
Entries Accepted from March 2 through June 1, 2009
Mail printed entries to: Margaret Sprott 11514 Regency Dr. Potomac, MD 20854

Submit electronic entries to: dick margaret@verizon.net

Check Division: Chapter/Council Large Club (76+) Small Club (4-75)
Name of PSA Group:

Location Served:

Editor’s Name: Home Phone:

Editor’s Street Address:

Editor’s City: State: Zip Code:

Editor’s E-mail Address:

Club’s Website:

Is Editor an individual member of PSA?
Title of Newsletter:

Is Editor a member of the PhotoEditor’s Group?

Electronic or printed?

Number of different issues per year?

Circulation - number of copies per issue: Printed:

Electronic:

For PSA use only Date entry received:

PSA Club/Council dues expiration date (required for entry)? Month:

Year:

Entry number:

New England Camera Club Council, Inc.
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NECCC Winter Interclub - | Wanna be a Cowboy by
Ed McGuirk of Boston West P$

B&W Interclub - Coming Home by Tony Schwartz
of Boston Camera Club

Winning 1st Place
Digital Images
In Various
Categories

Glennie Nature Competition Best Wildlife - Loon Feeding Chicks,
Ed McGuirk, Boston West Photographic Society

NECCC Winter Interclub Nature - Osprey with Catch by
Janet DiMattia of Cape Cod VF

NECCC Spring Interclub - Passing Through by
Shel Michaels of Nashua Forum
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Interclub Color Slides Class AA - Feels So Good by Marilyn
Cloran of Greater Lynn PA

NECCC Spring Interclub Nature 1st Place Digital - Osprey With Flounder
for Dinner by Lisa Cuchera of New Haven CC

NECCC Winter Interclub Print Competition Color - White Necked
Jacobin by Dan Brown of Photographers Forum

Spring- Color Nature Class B - Schwabacker Landing- by Dick Hudnall of Spring-Interclub Color Nature - Ruddy Turnstone by David Drislane of
Manchester CC Greater Lynn Photographic Association
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Drury’s Digital Diary - 2.2 Merged Layer

by Fred Drury

Previously I described alternative Clean-Up workflows depending upon the type of work that
was required to clean up the image. This issue I explain the need for, and the process of, creat-

N—— ..

ing a Merged layer. ] Layers l @
Cpacity

Merged Layer Lock: [ &+ & Fill

You will recall that several columns back I IE Clean-Up

identified important criteria around which this i

image optimization process is built. One of |§ Iil Farkground v

these was traceability ... to do the work such

that when one later reopened the file one could

clearly see the individual workflow steps. There- _ .

fore one could revert to any point in the process, == % ] ®. 4O & T .

make changes, and then complete the workflow

in the same manner as the original. Figure 1: Applying the Shadow/Highlight tool

will produce an error because Photoshop
believes ‘the active layer is empty’.

|
X

L Mews Layer, .. Shift+CErl+M
e Duplicate Laver. ..
Eill: n Delete Laver

Mew Group. .. Figure 1 shows the Layers palette for an image
a Mews Group from Layers, ., where the Clean-Up procedure has been complet-
ed. The next step is going to be a Shadow/High-
light process. Shadow/Highlight can only be ap-
plied directly to an image. The Clean-Up layer
on top of the Layers stack does not qualify. What

Convert ko Smart Object

Layer Properties. .. is needed is to combine the two layers shown into
Blending Options. . a third to which one can then apply the Shadow/
Create Clipping Mask, Al Chrl+G Highlight tool.

There are a couple of ways to do this in Photo-
shop®. First, click on the uppermost layer in the
Merge Down e stack to make sure it’s ‘active’. Looking careful-
Merge Visible Shift+CErI+E ly at Figure 1, notice the small down-pointing ar-

% row at the top right corner of the Layers palette...
Aimation Options , | clicking on this arrow will open what is called a
Palette Options. .. flyout menu (Figure 2). With a quick look at the
menu, you’ll see the Merge Visible choice

Flatten Image

Figure 2: The Layers Flyout menu is one
method of adding a layer of merged data to
the top of the Layers stack

Continued on page 35
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fourth up from the bottom. Unfortunately, if one
selects that command, Photoshop® will create
a merged layer, but one that replaces all the
other layers in the process thus compromising

traceability. The objective is to preserve those

existing layers and add the merged layer on top of
first hold
down the <Ctrl> and <Alt> keys, then click the flyout
menu arrow, and while holding down the left mouse
then
(while holding down the <Ctrl><Alt> keys) release |8
the mouse. The new Layer will be placed at the top
and automatically named

the layers stack. Here’s how to do it ...

button, drag the cursor to Merge Visible ...

of the stack (Figure 3) ...

‘Layer 1°.
I——— - X
| Layers x | =
Marrnal " Opacity: | 100% :Ir
Lock: [] & @ Fill: | 100% | »

[
= Ii Merged Layer

® | Clean-Up

b E Fackground £

= A0 0.0 4 3%

Figure 4: Layers palette with layer renamed
as ‘Merged Layer’

| Layers x | Vo=
Morrmal | Opacity: | 100% | # |
Lock: [ &+ @ Fill: | 1009 | »

o Bl [

Clean-Up

k- E Backarouna’ i

Figure 3: Double click on the Layer
name and you’ll be able to rename it as
appropriate

The second and easier way to do this is a key-
board shortcut. With the uppermost layer in the
stack ‘active’, use the left hand to hold down the
<Shift>, <Ctrl>, and <Alt> keys, then click the let-
ter ‘E” with the right hand. This too will put the
new merged layer on the top of the stack.

To change the name ‘Layer 1’ to something more
descriptive, double click on the existing name and
then enter your choice. In Figure 4, ‘Layer 1’ was
changed to ‘Merged Layer’. The resultant layer
stack is now ready for the application of the Shad-
ow/Highlights process.

In future columns I’1l introduce Photoshop’s Shadow/Highlight adjustment. Since Adobe added
this feature about three years ago, it has become an essential component of my image optimization

workflow.

GIVE ‘ﬂle GIFT of PSA

ahotographer tiend for Ris birthd

tfor a speaker or for an event ralfie?
ﬁ\:*-tr
s cart _J|||‘J| with
wdll b e
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NECCC Spring 2009 Electronic Interclub Competition

The Spring competition was held on April 1, hosted by the Cape Cod Viewfinders Camera Club. The competition was di-
rected by Peter Selig, MNEC, assisted by Diane Robertson who obtained the judges. Janet DiMattia and Abdul Raoof read
the scores and Debbie Owen and Don Moore recorded the scores on paper and a laptop computer. Tom Backman operated
the club’s computer with back-up provided by Bill Low. Thirty-three clubs participated in the Pictorial section and thirty
clubs participated in the Nature section.

The judges for the competition were:

Andre Bourque: Andre has been a camera club member for over 20 years. He has competed at Stony Brook Camera
Club in the AA level, receiving many awards for his outstanding work. Currently Andre was one of the early competitors to
go digital, and he took this new venture to a very high level by presenting a totally digital, highly creative show at NECCC
in the summer of 2004. This show has also been presented at camera clubs in the eastern states. Andre has conducted work-
shops on digital imaging and has had gallery shows of his beautiful prints.

Mary Doo: Immediate Past President of Photographic Society of Rhode Island (PSRI). Mary has won a number of
awards at NECCC, Glennie, and Greater Lynn International. She has been published by Meridian Printing at the Providence
Business Expo. Mary’s current endeavor is wedding and people photography. She is also passionate about Nature and
Wildlife Photography.

Sarah Musumeci: MNEC: Current Vice-President of Merrimac Valley Camera Club (MVCC). Sarah has judged at
NECCC, PSA, and at the local camera clubs. She is a travel and architectural photographer. She has been published in
Boston Magazine and Yankee Magazine, N.E. Travel and Life, Where’s Cape Cod Peterson’s Photographic Magazine, and
Cape Cod Travel Guide including 14 covers.

This Month’s Winners

The three winning clubs in the Pictorial section were:
Club Score Place
Boston 101 Ist
Boston West 100 2nd
Central NE 99 3rd

The winning clubs in the Nature section were:
Club Score Place
New Haven 112 Ist
Gateway 104 2nd
Cape Cod Viewfinders 103 3rd

The award winning photographs for the two sections were:

Pictorial:

Club Name Name Title Score Award
Boston Abramov, Ron Water Drop Reflections 29 Ist
Nashua Forum Nichaels, Shel Passing Through 29 18/Pick
Boston West Brady, Jim John O’Malley 27 3rd
Boston West McGuirk, Ed Horseneck 27 3rd
Bridgeport Gombeda, Bernard On the Lookout 27 3rd
Cape Cod Viewfinders Mills, Jim Blue Adobe 27 3rd
Central NE Christoph, Peter Christoph’s World 27 3rd
Greater Lynn Conley, Sue Sled Dog 27 3rd
Quinebaug Valley Leaf, Karen The Pressman 27 3rd

Continued on next page
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Continued from previous page

Nature:
Club Name Name Title Score Award
New Haven Cuchara, Lisa Osprey With Flounder For Dinner 30 1*/Pick
Bridgeport Brundage, Pat In Flight 29 2nd
Greater Lynn MclIntosh, Wendy Polar Bear and Ivory Gull 29 2nd

The “Pick” photograph in each competition was chosen by the judges to be published in the NECCC Bulletin. All First
place photographs will receive the same score and ribbon.

Within the next week or so the winning and HM photos in both sections will be posted on the NECCC web site (www.
NECCC.org). You might want to share that information with your club members who ask what types of photographs win.

Again in this competition two clubs entered photographs that had been entered previously; they were, of course, disquali-
fied. Clubs are responsible for maintaining records of all photos entered to be sure a photograph is not entered a second time.
If I can maintain such records for all the clubs for checking purposes, the club reps should be able to maintain records for a
single club. Remember, once a photograph has been entered it may never be entered again. Entry in pictorial means it may
not be entered in nature, and vice versa. These rules are slightly different from the rules used by the color and nature slide
competitions so reps should carefully read the new rules document when it is issued in late summer.

The Winning Clubs

The overall winning clubs in pictorial for the 2008-2009 competition were:

Club Total Score Place

Boston West 279 Ist

Bridgeport 269 2nd

Merrimack Valley 268 3rd

The overall winning clubs in nature for the 2008-09 competition year were:

Club Total Score Place

New Haven 294 Ist

Gateway 284 2nd

Cape Cod Viewfinders 281 3rd

The winning photographs from the three competitions will be sent to a judge outside of New England who will pick the
pictorial photograph of the year and the nature photograph of the year. Winners need to do nothing as I have all the photo-
graphs and will arrange the judging. The results will be announced at the awards ceremony on Sunday morning at the annual
NECCC Conference in Amherst. The club awards will also be presented at the same time. I hope to see all of you there.

Congratulations to all the winners.

Be sure to watch for the instructions for entering the 2009-2010 competitions. There will be some changes in the competi-
tions for next year so be sure to stay tuned.

William B. Barnett
Electronic Photograph Interclub Competition Chairman - Email: NECCC@optonline.net

Simply look with perceptive eyes at the world about you, and trust to your
own reactions and convictions. Ask yourself: “Does this subject move me to
feel, think and dream? Can | visualize a print - my own personal statement of
what I feel and want to convey - from the subject before me?”

Ansel Adams
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Spring 2009 / Final Interclub Print Competition Report

Reported by Arthur S. Vaughan, MNEC, NECCC Print Chairman

he Spring 2009 Interclub Print Competition was held on March 24 at the Seacoast Camera Club in Portsmouth, NH.
The event organizer and coordinator was Alan Bennett. Serving as judges for this competition were: Don Chick, Tom
Hindle, and Barry Nation.

Don Chick is the owner of a very successful portrait studio and has taught at the Seacoast Camera Club. A certified
professional photographer, Don has won numerous awards for his photography. Tom Hindle (www.imagesofthepast.com)
owns a professional photography studio, but his specialty is the restoration and printing of glass plate negatives. His busi-
ness is located in Stillwater, Minnesota. Barry Nation has owned three successful camera stores in New Hampshire, and is
now retired. He has presented programs on travelling to the Hymalayas and Hot Air Ballooning, and also served as a judge
at Seacoast on numerous occasions. A dedicated group of volunteers shared the work of getting prints ready for competi-
tion night, running the competition, and performing “wrap-up” work involved in getting prints ready for return to their
respective clubs: Alan Bennett, Paul Hopkins, Jackie Linder, Sandy McMillan, Kathy McQueeney, Eva Powers, and Mark
Stevens.

Many thanks go to the Seacoast Camera Club for accepting the offer to serve as the Spring 2009 host club, and especially
to Alan Bennett and all the members of the volunteer crew who shared the work involved in holding this event. This was the
first interclub print competition held at Seacoast, and their eagerness to “step up to the plate” is greatly appreciated. Many
thanks to all for a job well done! A total of 214 prints were submitted: 69 in Class A, 29 in Class B, and 116 in Color. Par-
ticipating were 28 clubs, 16 in Class A, 9 in Class B, and 28 in Color. There was a total of thirty eight award winning prints.
The the final club standings based upon cumulative point totals plus the results of the spring competition are listed belo

B&W Class “A” Fall ‘08 Winter ‘09 Spring ‘09  Final
Club Pts Place Pts Place Pts Place Total Place
Merrimack Valley Camera Club 95 1 89 3 93 3 277 1
Greater Lynn Phot. Association 89 91 1 96 1 276 2
Stony Brook Camera Club ) 92 3 88 93 3 273 3
Norwalk Camera Club 93 2 87 91 271
Manchester Camera Club 88 91 1 88 267
Greater Bridgeport Camera Club 87 84 84 255
Photographers Forum 83 77 95 2 255
Fall River Camera Club 81 85 87 253
Cape Cod Viewfinders 89 80 81 250
Wallingford Camera Club 84 80* 85 249
Eastern Maine Camera Club 78 82 88 248
Photographic Society of RI 85 79 84 248
Charter Oak Photographic Society 76 80* 89 245
Castle Craig Camera Club 81 73%* 87 241
Candlewood Camera Club 81 87 81 228
Springfield Photographic Society 81 & & 81
B&W Class “B” Fall ‘08 Winter ‘09 Spring ‘09 Final
Club Pts Place Pts Place Pts Place Total Place
Milford Camera Club 91 1 85 1 86 2 262 1
Southeastern CT Camera Club 83 2 85 1 85 253 2
Monadnock Camera Club 81 3 79 86 2 246 3
Seacoast Camera Club 77 73 94 1 244
Boston Camera Club 79 84 3 80 243
Windham Photography Club 80 79 67...3x 226
Housatonic Camera Club 41%* 76 67...3x 184
Pine Meadow Photographers 78 37...2x 41...2x 156
Flagpole Photographers 21... Ix & & 21

Continued on next page
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Continued from previous page

Color

Club
Merrimack Valley Camera Club
Photographers Forum
Charter Oak Photographic Society
New Haven Camera Club
Greater Bridgeport Camera Club
Photographic Society of RI
Stony Brook Camera Club
Greater Lynn Phot. Association
Norwalk Camera Club
Fall River Camera Club
Castle Crag Camera Club
Boston Camera Club
Candlewood Camera Club
Eastern Maine Camera Club
Manchester Camera Club
Southeastern CT Camera Club
Milford Camera Club
Cape Cod Viewfinders
Seacoast Camera Club
Windham Photography Club
Lakes Region Camera Club
Monadnock Camera Club
Seven Hills Camera Club
Wallingford Camera Club
Flagpole Photographers
Northern RI Camera Club
Pine Meadow Photographers
Housatonic Camera Club
Springfield Phot. Society

1x = One print submitted 2x = Two prints submitted
* = Includes subsequent make-up score

Individual Winners:

Fall <08 Winter 09
Pts Place Pts Place
90 93 1
99 1 89 2
94 89 2
98 2 81*

94 89 2
93 85

96 3 80

91 88

95 84

86 89 2
92 79%*

87 82

90 84

85 84

87 83

86 87

88 84

83 77

85 84

81 81

82 79

81 78

81 78

82 74%*

68... 3x 87

80 74

77 72

81* 71

90 &

B&W Class “A” (Score Range: 18-26 pts.)

PL. Pts. Club
st 26 Merrimack Valley CC
I 26 Photographers Forum
34 25 Greater Lynn Phot. Assoc.
34 25 Greater Lynn Phot. Assoc.
34 25 Stony Brook CC
HM 24 Charter Oak PS
HM 24 Eastern Maine CC
HM 24 Greater Lynn Phot. Assoc.
HM 24 Manchester CC
HM 24 Merrimack Valley CC
HM 24 Norwalk CC
HM 24 Norwalk CC
HM 24 Photographers Forum
HM 24 Photographic Soc. of RI
HM 24 Stony Brook CC

New England Camera Club Council, Inc.

3x = Three prints submitted

Maker
Glenn Guaraldi
Joe Drapeau
Karen Hosking
Len Tremblay
Tony Risica
Don Weston
Julie Butler
Greg Bartosik
Dick Hudnall
Les Wood
Sandy Gennrich
Ted Skeen
Ken Harvey
Donna Parker
Jim West

Spring ‘09 Final
Pts Place Total Place
97 1 280 1
89 277 2
90 273 3
92 2 271

85 268

90 268

92 2 268

86 265

85 264

87 262

90 261

91 260

86 260

90 259

89 259

84 257

80 252

89 249

79 248

83 245

83 244

85 244

84 243

83 239

83 238

76 230

73 222

84 219

& 90

TITLE
Acadia, Near Thunderhole
Lincoln Woods
After The Storm
On The Marsh
Say Uncle
Mormon Barn
Humble Harry
Baby Blues
Reflections
Brrr!
Rhyolite Mercantile
Window Washer
Doppeltebrueke
Dahlia #5
Flower

NECCC Bulletin - Spring 2009

& = No prints submitted

Continued on next page
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Continued from previous page

B&W Class “B”

Score Range: 18-25 pts.

PL. Pts. Club Maker TITLE

st 25 Housatonic CC George Mudge Crow

2nd 24 Monadnock CC Rhonda MacLeod Bridge

2nd 24 Seacoast CC Dick Davenport Colorado National Monument #3
2nd 24 Seacoast CC Sandy McMillan Tipped Over

2nd 24 Seacoast CC Eva Powers Waterfall In Yellowstone

2nd 24 Southeastern CT CC Drea Koval Flight Formation

2nd 24 Windham Phot. Club Scott Yeomans Katy #3

Color

Score Range: 17-28 pts.

PL. Pts. Club Maker TITLE

I 28 New Haven CC Frank Gilroy Bass Harbor Light

M 26 Merrimack Valley CC Glenn Guaraldi Bass Harbor Sunset

226 Stony Brook CC Jim West Banff #3

HM 25 Boston CC Beth Luchner Duck Trail

HM 25 Castle Craig CC Steve Wronker Rusty Old Memory

HM 25 Eastern Maine CC Jeremy Gray You’re Out

HM 25 Merrimack Valley CC Sarah Musumeci I’'m A Little Sad Today

HM 24 Charter Oak PS Austin Carey First Light

HM 24 Eastern Maine CC Suzanne Trussell Man Sleeping while waiting for wife shopping
HM 24 Fall River CC Cal Ellinwood Summer Evening, Rose Island
HM 24 Greater Bridgeport CC Bert Schmitz Bison In Morning Mist

HM 24 Manchester CC Joe Drapeau Winter Seascape

HM 24 Manchester CC Kent Messamore Motif #1

HM 24 Merrimack Valley CC Joan Francoeur Himalayan Blue Poppies

HM 24 Photographers Forum Sally Turner Sunflower With A Twist

HM 24 Stony Brook CC Tony Mistretta Valentine Rose

PSA Region 15 Report

by Robert B. Gorrill, APSA, MNEC

y personal thanks to Mary K. Hall, APSA,, MNEC for

her endeavors on behalf of PSA at the final meeting of
the Yankee Photographic Society. During the course of the
day-long event she managed to sign up several attendees to
join the ranks of the PSA. I also would like to express my ap-
preciation for all of the hard work that Jim Dionne, MNEC
puts in on behalf of PSA in the great state of Connecticut.

One of the great perks that were available to new mem-
bers, as well as long time members, was to be able to pur-
chase Adobe products direct from Adobe at a substantial
discount using a special code assigned to PSA. This was in
addition to any current discounts that were currently being
offered. One example is Adobe Lightroom where you would
come out ahead receiving it virtually free just for the cost of
a one year membership in PSA. The Society is working with
other companies to offer members substantial discounts on
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their products and will be announced in the PSA Journal.

The number of online study groups is exploding and in
the Electronic Imaging Division alone there are 30 groups
of seven members each going strong. Most of the groups
operate with each group member posting a new image each
month where they summarize what they did to that image
for presentation. The new images are usually posted on the
10th of every month. Then the other group members will
comment on the submitted images and those comments are
posted on the 25th of every month. It is most certainly a
great way to learn and to test your experiments in imaging
technology with your peers.

The PSA Electronic Imaging Division website is open
to all who would like to visit at www.psaphoto.org. If you
want to learn more about PSA contact me (rd15@photo-ne.
com), Mary (hallmaryk@pverizon.net) or Jim (jimski42@
sbcglobal.nef)and we will be happy to assist you. Visit the
Region 15 pages at http://psa-newmember.org/psa-regions/
regions/regl5.html.

New England Camera Club Council, Inc.



2009-2010 NECCC Digital
Circuit Details,

It’s time to prepare and send your entry dues and collect the
images for 2009-10 NECCC Digital Circuit. By now ou
should have received information about the circuits wit the
associated entry forms. As we did last year we will have two
categories, one general/open and the other will nature. Your
club may participate in one or both.

The Digital Circuit has been designed to make participa-
tion simple. The deadlines for the digital circuit are as fol-
lows: A participation form and the $5.00 fee per category
($10.00 for two) is due by June 30, 2009.

The deadline for image submission is July 25, 2009. This
gives us time to prepare the circuits for the judges, allows
them enough time to judge thoughtfully and record a com-
mentary. The circuit images will be assembled into a show
and the taped commentary will be used as the audio track in
the show. Individual CDs will be distributed to participating
clubs with any awards/ certificates and overall results just as
was done last year. If we do not receive the images on time,
the rest of the process will be much more difficult. Thank
you in advance for helping us out.

Please do send me your $5.00 fee per category by mail. A
single $10.00 check will be ok for entry into both Please note
that you do not need to predetermine your date for show-
ing the circuit images and commentary. It’s best to collect
six digital images per category before your club adjourns
for the summer. To further simplify matters you may sub-
mit your images via email to images@vertalis.com—be sure
to indicate your club name and the words “NECCC Digital
Circuit” in the subject line. In the event you are unable to
email images please prepare a CD and have it available for
the Sunday morning breakfast for NECCC reps at the July
NECCC conference. If this isn’t possible, please mail the
CD to me at the address above.

You should have received an email from me with a docu-
ment attached detailing the image preparation and naming
convention, a listing of the clubs and their short names and
a presentation outlining the circuit. Please be sure to follow
these guidelines as we would like to keep this process as
simple and automated as possible.

Thanks for your help. Let me know if you have any ques-
tions. I look forward to your clubs participation and hope
to see you at this year’s conference. You may reach me via
email sverma@vertalis.com or call 617-759-0010
Shiv Verma, MNEC

New England Camera Club Council, Inc.
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NECCC 2008 Models

L Photo by Goedon Y

2008 Conference Models

fficial photos of our 2008 Models at our Conference

are to be found on the next two pages The official
group photograph was taken by Gordon Yu of Quincy. The
models are listed by row in the group photograph..

Top Row: Irma Mikalaiciunas, Jamie Maguire, Audra
Burns, Kaitlyn Bolduc, Amber Faucher, Marina Antsiferova

Middle Row: Meagan Tantinarawat, Paige Kelly, Rebec-
ca Scalera, Mary Ann Isham, Monica Bradley, Alyssa King

Bottom Row: Jessica Strykowski, Joy Meredith, Alison
Campbell, Sunnie Anderson, Maya Johnson, Christa Gre-
goire

If you have any photos that you did not turn in to the
Model Committee of any of these young ladies it would be
greatly appreciated if you will do so as soon as possible.
They would love to see your photographs.

I know some photographs that are extraor-
dinary in their power and conviction, but it
is difficult in photography to overcome the
superficial power or subject; the concept
and statement must be quite convincing

in themselves to win over a dramatic and
compelling subject situation.

Ansel Adams
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Kailyn Bolduc Marina Antisiferova

Maya Johnson Meghan Tantimarawat Monica Bradley

Page Kelly Rebecca Scalera Sunshine Anderson
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Alison Campbell Alysa King Amber Faucher

Irma Milkalaiciunas

Jamie Maguire Jessica Strykowski Joy Meredith
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Editor’s Notes
by Robert B. Gorrill, APSA, MNEC

would like to express my thanks to all those who sent

cards and emails due to the problems I have been hav-
ing with my vision. Those problems still exist although there
does seem to be some slow, but sure, improvement.

It is important for each and every club to make sure that
their information is up to date with addresses, club meet-
ings, NECCC Representatives, club presidents, etc., so that
our material that is sent out to the clubs arrives in the prop-
er hands and that the information is passed on to the club
membership. Check your listing on the NECCC website and
make sure that the details about your club is correct. If it is
not then contact our webmaster and inform him as to what
needs to be changed.

Check the Winter 2008-09 issue of the NECCC Bulletin
and make sure that the club information is correct. If there
are changes, such as officers or club representatives, then
please send me email-editor@neccc.org. You should also
check the same information on the NECCC website where
you will find the listing of member clubs. Make sure that it,
too, is correct and up to date.

Donations to NECCC
Donations to NECCC by individuals and/or camera
clubs are welcome. They can be an excellent way to
remember a deceased friend, family member or camera
club colleagues, but they may be given for any reason. You
can be sure these donations will be put to good use. Dona-
tions to the NECCC Memorial Fund are used to help pro-
vide scholarships to worthy students who are residents of
New England and who are enrolled in a photography major
at an accredited college. Checks should be made payable to
the “NECCC Memorial Fund” and mailed to:
Richard A. Novak, MNEC
157 Forest Hill Road
Springfield, MA 01128
Donations to the NECCC General Operating Fund help
defray the operating expenses of the Council, including
thecost of services provided to member clubs and the ex-
pensesof the Annual Conference at Amherst. Checks for the

General Account should be made payable to “NECCC” and
should be mailed to:

Susan Mosser, FPSA, HonNEC
173 Central Street
No. Reading, MA 01864

All contributions are tax deductible and will receive a
written acknowledgement.

Page 26

NECCC Bulletin - Spring 2008

Dealing with a Color Cast
by Rick Cloran FPSA, MNEC

In this digital age, one thing that seems certain is that there
are a dozen or so ways to do almost everything in Photo-
shop. Here is one of mine for dealing with a color cast.

Open the image you want to edit

From the main menus select Image > Duplicate Image
and click OK to accept the default name and create the copy.

Working on the copy (duplicate) image from the main
menus select Filter > Blur > Average

This will turn the duplicate image into a uniformly toned
/ colored nothing. That is what you want as it provides input
for the correction

Reselect (click back on) your original image and posi-
tion it so that you can see it and the now blurred duplicate
at the same time. You don’t need to be able to see all of the
duplicate, just enough so that you can see a portion of the
uniform color.

Using either the menus ( Layer > New Adjustment Layer
> Levels and click OK to create the layer) or more simply
just clicking on the “Add New Adjustment Layer” icon (half
black - half white circle) in the bottom middle of the Lay-
ers pallet) on your Layers Pallet and selecting Levels add a
Levels Adjustment Layer to your original image.

Select the gray point (middle) eye dropper on the Levels
Adjustment Layer

Move the eye dropper over the uniform color on the du-
plicate and right click with your mouse to have the Levels
Adjustment Layer pick up that color as middle grey.

You should see an immediate change in your original im-
age colors as that blurred color (which contained the effect
of the color cast) is interpreted to be a clean 18 percent grey
(sans color cast). You can click to toggle the layer dialog box
image preview on and off to see the change that took place.

If you like the correction, click OK to accept the new Lev-
els Adjustment Layer on your original image. (If you need
to, you can still use the normal levels sliders to adjust the
whites, blacks and midtones in your image further before
accepting it or by reopening it later.)

Go back to the duplicated image and close it without sav-
ing. It has served it purpose

Try this on an image that you feel has a pesky color cast
that you haven’t been able to quite get out using other meth-
ods.
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NECCC Fall Interclub Print Competition - Class B - B&W - Snuggle Time
by Monica Baer of Milford CC

Visit our Web site at: www.neccc.org
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